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Chapter 1

The Inventory Module

The Inventory Module is used to monitor inventory used in the field and in relation to your customers.  
Inventory transactions are documented on-site using the Time Traveler™ keypad.   When the 
Shadow Tracker™ unit is downloaded these transactions are added as Unprocessed Activity.  From 
here, they are reconciled and processed ( current inventory stock is updated ) to show the exact 
distribution of all materials expended for a job.

Contents of this Chapter

! Adding Inventory Records
! Approving New Inventory Transactions
! Processing New Inventory Transactions
! Viewing Approved Inventory Transactions
! Export
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Adding Records

Each inventory record consists of an inventory number,  an inventory item id,  a description and a 
stock quantity.   When you first open the Inventory Module the inventory records window will 
become visible.   From here you add,  edit or delete inventory records.   You can move through these 
records using the navigation buttons available.   To access these inventory records at anytime,  click 
the barcode button           from the toolbar.

If you wish,  Shadow Tracker™ will track your inventory stock on hand.   When an inventory record is 
added,  the quantity field should match the company's quantity on hand.   When inventory 
transactions are processed,  the quantity of each inventory record is re-calculated.   Shadow 
Tracker™ will not report a negative stock balance.   Therefore,  once an items stock is depleted,  the 
quantity field is ignored.   If you do not wish to use Shadow Tracker™ for tracking inventory stock,  
enter a zero value in the quantity field of each inventory record.

Accessing the Inventory Module

To access the Inventory Module click File >> Open >> Inventory Transactions  from the menu.

The Inventory and Time Modules require a Week Ending parameter be set before you can begin 
working.   The Week Ending parameter will denote the workweek schedule for your company.   If you 
have set up Shadow Tracker™ Professional as a Client/Server install,  the Week Ending parameter 
will set by the System or Network Administrator from the Base unit or network server.   If you have set 
up Shadow Tracker™ Professional as a StandAlone install,  you will be prompted to set the Week 
Ending Parameter the first time you open either of these modules.
NOTE:   Once set,  this parameter cannot be changed.

Reconciling New Transactions

Each time a tracking unit is downloaded,  if the unit contains recorded inventory transactions,  these 
transactions are added to the Shadow Tracker™ database as Unprocessed Inventory.   You may view 
these newly added transactions by clicking the keypad button on the toolbar.

As transactions are downloaded,  each transaction is validated.   This validation process compares 
the new transactions to the actual records in the database.   This validation is necessary because 
there is always the potential for user input errors when entering data into the Time Traveler™ keypad.   

Unreconciled inventory transactions are added with the approved OK column marked red.   A red 
mark indicates the record has not yet been reviewed by you.   Each transaction should be reviewed 
for accuracy before it is marked for approval.

Notice that record number three does not have a valid inventory item or employee.   Instead,  the actual keypad entry is displayed.

Modify a transaction by selecting the record with your mouse and clicking the Edit button.   An area 
will appear at the bottom of the window where you should make the necessary modifications.   Click 
Save when done.
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Inventory Item

Customer

Note:   You can view the transactions on-screen or create printed reports.   If a transaction must be 
edited and/or deleted you will have to manually update the quantity of that inventory record ( unless 
you are not tracking quantity ).   Only during download is inventory quantity updated.

Approving New Transactions

When you have made the necessary edit to your transaction,   mark it approved by double-clicking 
the OK field changing the icon from red to green.   That transaction is now ready for processing 
against the company inventory records.

Viewing Approved Transactions

Processed transactions can be sorted by inventory item,  customer or employee.   Select the 
appropriate button on the toolbar for the view you want:

Processing New Transactions

Processing inventory transactions updates the in-stock quantities and moves the transaction into 
Approved Inventory.   Only inventory transactions that contain valid data and are marked with a green 
icon will be considered for the processing function.   Therefore,  before you can create a Report to 
view your new inventory,  you must process the transactions first.

Process inventory transactions by clicking the Process button.   All records that clear validation will 

Employee

Clears the grid

Exporting Transactions

When inventory transactions are processed they are again displayed with the approval OK field set to 
unapproved or red.   This allows you the opportunity to once again review your transactions before 
you export them for further accounting needs.

Mark inventory transactions ready for export by double-clicking the OK field changing the icon from 
red to green.   Only those items with a green icon will be exported to an ASCII file.   Once exported, 
the icon is changed to a red “X”,  which indicates the transaction is locked and cannot be modified.   
At this point,  you will probably want to delete those records that were exported.   ( Refer to the Export 
Module for more information )

Chapter 2

The Time Module

The Shadow Tracker™ Time Module and Time Traveler™ allow you to use your Shadow Tracker™ 
field unit as a portable time clock.   You can easily keep records of an employees' time,  job activities, 
inventory usage for job costing, cash receipts and vehicle odometer readings in addition to the GPS 
track activity you are already gathering.   These records are downloaded to your Shadow Tracker™ 
system at the same time you download GPS data.   Shadow Tracker™ Time takes the keyed time 
information and displays it for easy analysis.   Those records can then be viewed, edited, reported 
and even exported as needed.

Contents of this Chapter

! Downloading Time Data
! New Activity
! Unprocessed Transactions
! Processing Transactions
! Employee Time Transactions
! Customer/Job Transactions
! Vehicle Odometer Transactions
! Approving Transactions
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Accessing the Time Module

To access the Time Module click File >> Open >> Time Transactions  from the menu.

The Inventory and Time Modules require a Week Ending parameter be set before you can begin 
working.   The Week Ending parameter will denote the workweek schedule for your company.   If you 
have set up Shadow Tracker™ Professional as a Client/Server install,  the Week Ending parameter 
will set by the System or Network Administrator from the Base unit or network server.   If you have set 
up Shadow Tracker™ Professional as a StandAlone install,  you will be prompted to set the Week 
Ending Parameter the first time you open either of these modules.
NOTE:   Once set,  this parameter cannot be changed.

Downloading Time Data

Each time a tracking unit is downloaded and includes time transactions they are added to the Shadow 
Tracker™ database.   As transactions are downloaded,  each transaction is validated.   The validation 
process just means that the entered data is compared to actual records in the database.   Because 
there is always a potential for data input errors whenever users enter information using the Time 
Traveler™ keypad,  this validation is necessary.

Time transactions that pass validation are added automatically as New Activity.   If the transaction 
does not pass validation it is added to the Unprocessed Transactions area.   These two areas are 
described in detail below:

New Activity - All validated time transactions that have not been approved for export.

Unprocessed Transactions - Transactions that could not be validated.

New Activity

This area is designed to give you a central location to view all of your keypad entries before approval 
for export.   When using the Time Traveler™ keypad entries that can be added are:

Time In
Time Out
Job In
Job Out
Odometer Transactions

New Activity will include all of these types of input data.   New Activity is an area setup for viewing 
these transactions.   You cannot modify or adjust records in this area.   Once transactions reflect 
approval, they are removed as New Activity and will only be viewable as Employee Time,  Customer 
Job or Vehicle Odometer transactions.

Click the New Activity button from the toolbar.   A grid will populate with all of the validated,  but 
unapproved keypad entries in date/time order.

To merge duplicate fields,  Click on the title bar in New Activity .

Note:   It is recommended that your company devise a policy determining how and when keypad 
entries should be made.   Having a uniform format of data input will make interpretation of the data 
much easier.
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Unprocessed Transactions

As mentioned earlier,  upon download Shadow Tracker™ attempts to validate keyed entries against 
database records.   Unprocessed transactions are a result of:

1.  The information was not keyed correctly into the Time Traveler™ keypad,  or 
2.  the transactions do not match a valid vehicle issue record.

Reconcile these transactions and process them into New Activity by correcting the errors.   To view 
these transactions, select the week ending date and click the Unprocessed Transactions              
button from the toolbar.

Unprocessed transactions exist due to invalid data.   Either the data received from the keypad is 
wrong or the database is incomplete.   When a transaction is downloaded they are associated with a 
driver and/or a vehicle.   When each entry is made into the keypad,  the user is asked to input some 
identifying information such as the Employee ID,  Customer ID,  Job ID,  Inventory ID,  Quantity,  
Odometer Reading,  etc.   If any of this information was entered incorrectly,  it must be reconciled.   
The Shadow Tracker™ Time Module will display each keypad entry exactly as it was entered into the 
keypad.

To modify a time transaction:

1.   From the Unprocessed grid click the Edit button.   You are now in edit mode.  Notice the indicator 
at the top of the screen.

2.   Select the transactions by clicking on it with your mouse.   The transaction will populate in an 
editing panel.   Field values that could not be matched with your database will be left blank.

3.   Make the appropriate modifications for each field.

4.   When you are sure the correct data has been entered click the Save Changes button.   Once you 
have opened a transaction for editing it must be reconciled in full before you can save it.
To cancel changes to a transaction before saving,  click the Cancel button.

Deleting a transaction from the Unprocessed transactions area permanently removes it from the 
database.

Note:   Validation of the vehicle/driver relationship is done when transactions are processed,  not 
when you save modifications to transactions.

Processing Transactions

Once you have reconciled all unprocessed transactions,  you are ready to move them into New 
Activity.   Do this by clicking the Process button.   The Shadow Tracker™ Time Module will then 
validate each field for pass or fail.   Transactions that pass validation are added as New Activity and 
removed from the Unprocessed grid.   Those transactions which do not pass validation are not 
removed and will require further review.

As transactions are processed they become available as New Activity,  Employee Time,  Customer 
Job or Vehicle Odometer transactions.

Employee Time transactions - Validated Time transactions by employee and week 
ending date.

Customer/Job transactions - Validated Job transactions by customer and week 
ending date.

Vehicle Odometer transactions - Validated Odometer transactions by vehicle and 
week ending date.

Once transactions are processed they are ready for review before they are exported or analyzed by 
the reporting module.  To indicate the record has passed approval mark the OK field green.  All 
transactions are added with no approval (Red icon), once approved the OK field is changed to green.

8 9



Unprocessed Transactions

As mentioned earlier,  upon download Shadow Tracker™ attempts to validate keyed entries against 
database records.   Unprocessed transactions are a result of:

1.  The information was not keyed correctly into the Time Traveler™ keypad,  or 
2.  the transactions do not match a valid vehicle issue record.

Reconcile these transactions and process them into New Activity by correcting the errors.   To view 
these transactions, select the week ending date and click the Unprocessed Transactions              
button from the toolbar.

Unprocessed transactions exist due to invalid data.   Either the data received from the keypad is 
wrong or the database is incomplete.   When a transaction is downloaded they are associated with a 
driver and/or a vehicle.   When each entry is made into the keypad,  the user is asked to input some 
identifying information such as the Employee ID,  Customer ID,  Job ID,  Inventory ID,  Quantity,  
Odometer Reading,  etc.   If any of this information was entered incorrectly,  it must be reconciled.   
The Shadow Tracker™ Time Module will display each keypad entry exactly as it was entered into the 
keypad.

To modify a time transaction:

1.   From the Unprocessed grid click the Edit button.   You are now in edit mode.  Notice the indicator 
at the top of the screen.

2.   Select the transactions by clicking on it with your mouse.   The transaction will populate in an 
editing panel.   Field values that could not be matched with your database will be left blank.

3.   Make the appropriate modifications for each field.

4.   When you are sure the correct data has been entered click the Save Changes button.   Once you 
have opened a transaction for editing it must be reconciled in full before you can save it.
To cancel changes to a transaction before saving,  click the Cancel button.

Deleting a transaction from the Unprocessed transactions area permanently removes it from the 
database.

Note:   Validation of the vehicle/driver relationship is done when transactions are processed,  not 
when you save modifications to transactions.

Processing Transactions

Once you have reconciled all unprocessed transactions,  you are ready to move them into New 
Activity.   Do this by clicking the Process button.   The Shadow Tracker™ Time Module will then 
validate each field for pass or fail.   Transactions that pass validation are added as New Activity and 
removed from the Unprocessed grid.   Those transactions which do not pass validation are not 
removed and will require further review.

As transactions are processed they become available as New Activity,  Employee Time,  Customer 
Job or Vehicle Odometer transactions.

Employee Time transactions - Validated Time transactions by employee and week 
ending date.

Customer/Job transactions - Validated Job transactions by customer and week 
ending date.

Vehicle Odometer transactions - Validated Odometer transactions by vehicle and 
week ending date.

Once transactions are processed they are ready for review before they are exported or analyzed by 
the reporting module.  To indicate the record has passed approval mark the OK field green.  All 
transactions are added with no approval (Red icon), once approved the OK field is changed to green.

8 9



Employee Time consists of all Time In and Time Out keypad entries.   These transactions are sorted 
in the grid by the entry date and time.   From this grid you can add,  modify,  delete,  approve and 
disapprove employee time transactions.

Reconciling and Modifying Time Transactions

To add a new transaction or make modifications to an existing transaction, click the Add or Edit 
button.   Fill in the appropriate changes to the record and save.

Employee Time Transactions

Employee Time is where you adjust and approve employee time 
transactions.   To view,  click the Employee Time Transactions button.

Select the week ending date and employee name from the drop-down lists.   
If time transactions exist for these choices,  they will populate in the grid.

Customer Job consists of all Job In and Job Out keypad entries.   These transactions are sorted in 
the grid by the entry date and time.   From this grid you can add,  modify,  delete,  approve and 
disapprove customer job transactions.

Reconciling and Modifying Customer Transactions

To make modifications to an existing transaction, click the Add or Edit button.   Fill in the appropriate 
changes to the record and save.

Customer/Job Transactions

The Customer Transactions grid displays customer related job transactions.   From here,  you can 
determine information such as which employees are on which job site and the amount of time that is 
being spent in relation to a particular job or customer.

Select the week ending date and then click the               button on the toolbar.   Next,  select a 
customer from the drop-down list.   The grid will populate with transactions sorted according to 
Customer ID for the selected week.
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Vehicle Odometer Transactions

Shadow Tracker™ Time makes it easy to view odometer entries made by the Shadow Tracker™ 
keypad.   These entries are sorted by Vehicle ID as they are downloaded and can be viewed week by 
week from the Vehicle grid.   You can modify transactions but cannot add from this area.
 
To view odometer transactions select the week ending date you wish to view.   Then, click the               
button from the toolbar and select a vehicle from the drop-down list.

The grid will populate with transactions for the week ending date you selected.

Reconciling Odometer Transactions

Select the transaction you wish to change.  Click the Edit button which opens the odometer field for 
changes.   Make your change to the transaction,  then click the Save button or Cancel to disregard.   
You cannot add odometer transactions in this area.   Odometer readings must be added from the 
Unprocessed transactions grid,  then processed into Vehicle Odometer transactions.

Approving Transactions

By approving transactions you are indicating that they have been reviewed and authorized as a valid 
entry.   Approving a transaction:

1.   Removes it from the New Activity area.
2.   Sets a flag allowing the transaction to be included in export.

Transactions can be approved one at a time or in groups.   To approve them,  select the transactions 
using your mouse then click the Lock button.                       Notice that the OK field in the selected 
transactions turn green to indicate the change.

If you change your mind you can disapprove a transaction before it has been exported by selecting it 
and clicking the UnLock button.

Obtain a copy of the Employee Time Sheet and other time/job related information from the Reports 
window.  Refer to the Reports section of the Shadow Tracker™ Professional Software manual and the 
Shadow Tracker™ Reference Manual for more information on the reporting feature.
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1.   Removes it from the New Activity area.
2.   Sets a flag allowing the transaction to be included in export.

Transactions can be approved one at a time or in groups.   To approve them,  select the transactions 
using your mouse then click the Lock button.                       Notice that the OK field in the selected 
transactions turn green to indicate the change.

If you change your mind you can disapprove a transaction before it has been exported by selecting it 
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window.  Refer to the Reports section of the Shadow Tracker™ Professional Software manual and the 
Shadow Tracker™ Reference Manual for more information on the reporting feature.
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Chapter 3

The Export Module

The Export Module is a time-saving utility that allows you to automate the transfer all of your data 
from the Time and Inventory Modules.   Once your time and inventory data has been reconciled,  and 
you are ready to transfer it into your accounting system,  by utilizing the Export Module you will be 
able to quickly create a comma-delimited ASCII file that can be used for exporting your data directly 
into your company's accounting system software.

Contents of this Chapter

! Preparing for Export
! Standard Export Module
! Professional Export Module
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Standard Export Module

The Shadow Tracker™ Standard Export module contains pre-set export templates which contain 
fields that are required by the accounting software you select.   Some of the fields will not contain 
data however they are necessary for the import process to function properly.

! Click the program area ( Time,  Inventory,  Cash Receipts ) to access the type of data for 
which you wish to build an export file,   then click Next.  ( Figure F )

! Select the accounting package and template,  then click Next.  ( Figure G )

The information in the parameters form are separated into three sections:  Format,  Filter and 
Options.  ( Figure H )

Figure G

Figure H

The Format section defines the layout of your export data as required by the selected accounting 
software.

The Filter section defines what data you want to be included in the export.   Based on the modules 
included in your Shadow Tracker™ purchase you can filter data by employee,  customer and /or 
inventory item.

The Options section defines parameter requirements that are specific to your accounting software.

Figure F

The Export buttons for each of these areas will be enabled or disabled based on whether you have 
purchased that export program.   Each area functions the same except for parameters you must 
supply,  which are accounting package specific.

In order to build an export file you need to either create a template or use a pre-existing template.   
The template defines the number of fields in your file,  their name,  size,  data type and the Shadow 
Tracker™ data each field should contain.   In order to understand how your template should be 
structured you will need to be familiar with the import process of your accounting software.

Preparing for Export

First,  click Tools >> Export  from the menubar.

Next,  determine which Export module ( Standard or Professional ) is included in your package by 
referring to the caption from the export form.   In both the Standard and Professional module there are 
three distinct program areas that access the type of data from which you can choose to export:

  Time Module   Inventory Module        Cash Reciepts
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Professional Export Module

The Shadow Tracker™ Professional Export module allows you to define your own export templates.   
You can save your templates for future exports or re-define new ones.
To begin creating a new template:

· Select Build a new structure,  then click Next.

You will be prompted for an export name and a template name.   Click Next.   A parameter form will 
appear where you will indicate the dates for the data you want and how the data should be presented.

Options define the date/time format of any date fields,  whether employee and customer fields should 
contain an ID number or a name,  and if you want to export actual time data or total time calculated.   
After making these selections,  click Next to continue to the next form.

Once you have specified the format and parameters for your export,  you will need to begin setting up 
the template file.

! When you are ready to view your Export file click Next.

· Review the data that will be included in your Export file.   Add or Modify any fields as 
required by your accounting software.   ( Figure I )

· Once you are sure the data is ready for export click the Validate button to determine any 
obvious errors.   If your data passes validation and you are ready to build your export file,  
click the Next button.

A message box will appear indicating the name and location of your export file.   You are now ready to 
import this file into your accounting software.

Figure I
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Now that your fields are defined,  you need to indicate what Shadow Tracker™ data should be 
associated with each field.

For each field,  match the data field from the drop-down listbox.   Each listbox includes a descriptive 
name of all of the fields available for export.   A field called Blank is also included for any required 
fields that will not contain data.

Scroll through all of the fields using the Cont. Up and Cont. Down buttons.

When associating the fields with their data,  make sure that you are selecting fields with the same 
type of data.   For instance,  a name field can only be associated with a text type field,  and a date 
can only be associated with a numeric type or date type field.   Click Next to view the data for the 
fields you have selected.

Your data will appear in a grid where it can be modified and reconciled as needed.

Once the file format is satisfactory validate the data by clicking the Validate Data button.   The 
validate routine checks each field in the grid against the associated data type,  field size, etc. and 
verifies that it can be exported.

A message box will appear indicating the name and location of your export file.   You are now ready to 
import this file into your accounting software.

When you click the Next button from the parameters form you are prompted for the number of fields 
you want in your export file.   This number should include all required fields even if those fields will not 
include Shadow Tracker™ data.   Click OK to set the number of fields.

From the Structure form you will indicate the field order,  field name,  data type and size for each 
field in your export file.

Fill in the appropriate information under Field Structure and click the right pointing arrow button to add 
that field to the file structure.  

Click the left pointing arrow button to return a selected field or make modifications.   If you make a 
mistake and cannot recover click the Back button to start again.  

Click the Next button when you are ready to continue.
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Chapter 4

The Equipment / Vehicle Monitoring ( EVM ) Module

Managing employees and a fleet of vehicles is challenging enough.   The EVM Module is designed to 
help further remove the guess work out of what is occurring with your employees and vehicles in the 
field.

What is EVM?
EVM is the acronym for Equipment / Vehicle Monitoring.  It is currently available with the Shadow 
Tracker™ 2000 Tracking unit ( ST2000 ).   The EVM Module allows you to monitor,  record and 
archive the daily status of a wide assortment of vehicle components.   Upon installation you can begin 
to record data and generate daily reports that will help you more effectively monitor and manage  the 
day to day operation and maintenance of your vehicles,  as well as the work routines of your 
employees.

How does it work?
By utilizing the sensors / circuits already installed on your vehicle,  the ST2000 monitors and records 
the status of a wide variety of vehicle components / systems.   Each ST2000 comes equipped to 
monitor two digital signals,  and after installing the EVM cable you will be ready to begin collecting 
data.   The information you record will be as accurate as the sensor equipment installed on your 
vehicle by the manufacturer.   Throughout the day,  each time there is a change in the “state” of a 
particular component,  the information is recorded by the ST2000.   Then,  when the ST2000’s data 
has been downloaded and processed,  you can display GPS Tracking activity and create reports  to 
provide a clear and accurate view of the moment to moment status of your vehicles components for 
any given time interval.

Contents of this Chapter

! EVM Requirements and FAQ’s
! The Edit a Vehicle Form
! Assigning an ST2000 to a Vehicle Record
! Sensor Ports

Defining
Editing
History

! Viewing EVM Data
Historical Tracks
Reports
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EVM Requirements

What do I need to begin collecting and processing EVM data?

! Shadow Tracker Professional Software installed with the EVM Module enabled.
! An ST2000 unit that has been validated and authorized for use.
! An EVM cable,  properly installed and connected to the ST2000.
! At least 1 valid and active Vehicle Record that has been assigned to an active Employee 

via the Vehicle Issue process.
! The ST2000 assigned to a valid and active Vehicle Record.
! Sensor ports defined to correspond to the EVM cables’ installation.

Frequently Asked Questions

What kinds of components can I monitor?
The EVM Module is currently configured to monitor digital signals.
Some examples of components that could be monitored using a digital signal are;  engine RPM,  A/C 
compressor,  turn signals,  emergency flashers,  doors,  hood,  trunk,  horn,  headlights,  seat belts,  
etc..

What is an EVM cable?
An EVM cable is used to connect the vehicle sensor switches or circuits to the ST2000.   An EVM 
cable has a DB9 female connector on one end that plugs into the back of the ST2000 unit.   The other 
end has 4 sensor connection wires used to link into the vehicles sensor switches or circuits,  allowing 
you to monitor 2 vehicle components.
Please note:   It is the responsibility of the End-User to ensure that the EVM cable is properly 
installed.

How do you install an EVM cable?
Instructions for properly installing an EVM cable are outlined in the Shadow Tracker™ 2000  
Hardware Manual.

What is a sensor port?
A sensor port is simply a dedicated communication path on an ST2000 Tracking unit.   The port is 
linked,  via an EVM cable,  to a vehicle sensor.   Sensor ports are assigned a unique Name and 
defined according to the component being monitored and the “states” that are being monitored.

What is a “state”?
In the context of the EVM Module a “state” is one of two possible conditions that can exist for a 
particular sensor port,  with State1 being considered the “active” state and State2 the “inactive” state.
Example:  For the sensor port named “Door”,  State1 could be designated “Open” and State 2 could 
be designated “Closed”.   Or for the sensor port named “Emergency Flashers”,  State 1 could be “On” 
and State 2 could be “Off”.

What does it mean to Define a sensor port?
Defining a sensor port is simply assigning captions for the Name,  State1 and State2 fields that will be 
used whenever you view EVM GPS data and view reports.   The Name is for the component that the 
sensor port will be monitoring,  and State1 and State2 are for the corresponding conditions that the 
EVM cables' connection wires are linked to monitor.
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The Edit a Vehicle Form

The Edit a Vehicle form is where all EVM maintenance and functionality occurs for Editing sensor 
ports,  viewing EVM History or creating EVM Reports.

From the PC Desktop:
Click Start  >Programs  >  Shadow Tracker Professional  >  Shadow Tracker

From the Shadow Tracker Mapping 3.2 interface:
Click File -> Open -> Vehicle Records,  and <Click>  the Vehicle you wish to Edit.

EVM Ports Definition

The Name column is where you enter the caption or phrase you wish to associate with this vehicle 
component.

The Date column displays the Start Date that this unique Vehicle# / Tracker# / Port Definition 
combination was added.

Columns State 1 and State 2 are used for defining the states of the vehicle component you are 
monitoring.   

For example:
Port Name State1 State2
1 Door Open Closed
2 Emergency Flashers On Off

Please note:  Enter the caption that correctly corresponds to the EVM cables sensor wire installation 
for that particular sensor port.   The caption chosen here will be used later whenever you create a 
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Sensor Ports

Defining

3) Define the sensor ports.

Sensor Ports can only be defined for ST2000 unit’s that have been validated and authorized for use.   
Sensor Ports can be defined or redefined by accessing the Vehicle Record form.

1) Follow instructions for Validating your Tracking Units
( See Shadow Tracker Professional - Administrator Manual,  page 21 )

At the end of the validation process you will receive a Message Box asking   
“Do you wish to collect sensor data with this unit?”   Select  Yes.

2) Assign the ST2000 to a valid Vehicle Record. ( page 26 )

From Shadow Tracker Mapping 3.2
! Select  File -> Open -> Vehicle Records

<Click>  

! <Click>  the vehicle record the ST2000 is assigned to

From Edit a Vehicle
! Select  Edit Ports
! Enter captions for the Name,  State1 and State2 columns
! Save Ports

Assigning an ST2000 to a Vehicle Record

Assigning

Before you can download or properly process sensor data,  the ST2000 unit must be assigned to a 
valid Vehicle record.

From Shadow Tracker Mapping 3.2
! Select  File -> Open -> Vehicle Records

! <Click>  the downward arrow beside the Tracker # box.   Highlight the Tracker # you wish 
to assign to this Vehicle record from the drop-down menu.

! <Click>  Save.

Unassigning

To unassign an ST2000 unit from a Vehicle record,  do the following.

From Shadow Tracker Mapping 3.2
! Select  File -> Open -> Vehicle Records

 the Vehicle record that the ST2000 is currently assigned to.
! <Click>  the downward arrow beside the Tracker # box and highlight “None Assigned” from 

the drop-down menu.
! <Click>  Save.

Reassigning

ST2000 tracking units can be easily reassigned to a different Vehicle record.   But,  before the unit 
can be reassigned,  it must first be Unassigned.   Once this is done the ST2000 can be reassigned to 
a new Vehicle record by following the instructions for assigning an ST2000 to a Vehicle.

! <Click>  the Vehicle you wish to assign.

! <Click> 
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Editing

Sensor ports can be edited or redefined by opening the Vehicle Records Form

1) From  Shadow Tracker Mapping 3.2
! Select  File -> Open -> Vehicle Records

You now have access to redefine the Ports as needed.

<Click>  

Note:  The Historical data collected for the previous unique Vehicle# / 
Tracker # / Port Definitions combination will be archived into EVM 
History.   The data will be accessible by way of this unique 
combinations’ Start and End dates.

! <Click>  the vehicle record that the ST2000 is assigned to.
! Select  Edit Ports

! Enter captions for the Name,  State1 and State2 columns.
! Save Ports
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History

A unique combination is created whenever a Vehicle# is assigned to a Tracker #, and the sensor 
ports are defined.   EVM History provides an interface to view all past sensor port definitions 
associated with a particular Tracker #.   These records are displayed chronologically according to the 
Start and End dates of the combination.   Whenever an existing combination is modified in any way 
and then saved,  a new unique combination is created and the previous combination is archived.   It is 
possible to recreate previous combinations,  but because they will have different Start and End dates 
they will never be identical.

EVM History can be viewed from the Monitoring History form.

From  Shadow Tracker Mapping 3.2
! Select  File -> Open -> Vehicle Records

! <Click>  History.
! <Click>  the Vehicle that you wish to view.

You now have access to view the EVM History for all Vehicle / Tracker combinations.

Viewing EVM Data
Once collected and processed it can be viewed in two different ways.   Either as 
part of an Historical Track display of GPS data or as an EVM Report. 

Historical Track

EVM data has been 

To view EVM data as part of an Historical Track,  do the following.

From Shadow Tracker Mapping 3.2
! Select  View -> Historical Tracking -> Select 

Track...

From View Historical Track

! Select Start and Stop Date
! Select Start and Stop Time
! Check the Vehicle #
! Select either Port Name or Port State
! <Click>  Build

! Choose Track/EVM

The EVM data is displayed on the Historical track as a 
series of numbered,  colored circles.   Each circle 
displays the port number and the caption associated with 
the port state, with green indicating the active port state 
and red the inactive port state.
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Historical Track

EVM data has been 

To view EVM data as part of an Historical Track,  do the following.

From Shadow Tracker Mapping 3.2
! Select  View -> Historical Tracking -> Select 

Track...

From View Historical Track

! Select Start and Stop Date
! Select Start and Stop Time
! Check the Vehicle #
! Select either Port Name or Port State
! <Click>  Build

! Choose Track/EVM

The EVM data is displayed on the Historical track as a 
series of numbered,  colored circles.   Each circle 
displays the port number and the caption associated with 
the port state, with green indicating the active port state 
and red the inactive port state.



EVM Reports

The Monitor Activity Report displays all sensor port activity for a specified time period,  detailing the 
Start / End time,  Port State and Duration of all sensor port changes.   Each report also includes a 
summary to provide a quick overview of activity.

Monitor Activity Reports can be created and viewed from the EVM Reports form.

From Shadow Tracker Mapping 3.2
! Select  File -> Open -> Vehicle Records

! <Click>  Report.

From Equipment / Vehicle Monitor Reports
! Select Start and Stop Date
! Select Start and Stop Time
! Check Vehicle #
! <Click>  Initiate Report

! <Click>  the Vehicle you wish to view.
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! Select  File -> Open -> Vehicle Records
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! Select Start and Stop Date
! Select Start and Stop Time
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P.O. Box 168 
Sugar Land, Texas 77487

Tel:    (713) 353-6065
Fax:  (713) 353-6050
www.AdvanTrack.com
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